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0.1 Overview
In this session, we will have an overview of GIS, including the most popular used open source
GIS platform QGIS, the basic and most common vector and raster file types, and zonal statistics
analysis. The tools and techniques used in this lesson will be used in all following lessons, and these
materials should be helpful as reference in the future. Note you can either use the paperspace online
environments or, if you have a laptop with sufficient memory and power, install QGIS locally. Note
that later assignments may require more memory and computation than you have available on your
laptop; in those cases you can instead move to cloud environments.

0.2 QGIS
To open QGIS, double click on the QGIS icon in your Paperspace desktop.

Once QGIS is launched you should see a window similar to the one below.

Figure 1: Screenshot of QGIS interface

There are several main elements to the QGIS interface:

1. The toolbars along the top include the most often used tools for loading and working with
spatial data. If the tools are not visible in a toolbar, you can find them from the menus.

2. The layer list on the left side will populate with your spatial data layers as you add them.
3. The processing toolbox on the right shows the list of all available algorithms grouped in

different blocks.
4. The status bar along the bottom shows you information about the current map view.
5. The map canvas in the center is where your spatial data will be visualized.

There are a wide variety of geospatial tools, functions, and analysis procedures available through
the core QGIS library, however, some GIS processes have yet to be integrated into QGIS. Fortunately,



2

there is an increasingly large population of developers and users who are contributing to QGIS’s
functionality by developing plugins (searchable using the Plugins menu). All plugins used in this
tutorial have been pre-installed and activated for you.

More on QGIS can be found at https://qgis.org/.

0.3 Loading and Exploring Data
In this section we will explore several datasets which represent the types of data you might want
to include in a Geospatial Impact Evaluation (GIE), and basic processing steps needed to prepare
data for a GIE. The Nigeria State boundaries will represent the unit of analysis for the GIE, the
commitment dollar values of GEF projects can be used as a treatment indicator, and NDVI (a satellite
based measure of the "greenness" of vegetation) could be used as an outcome measure.
These datasets are all available in the data folder included in your download from earlier, and are
summarized in the list below.

1. Nigeria State Boundaries
• Description - Spatial features defining the boundaries of first order administrative zones

(states) in Nigeria
• Source - GeoBoundaries database of administrative zones1

• File Type - Vector (GeoJSON, .geojson)

2. GEF Geocoded Aid Projects
• Description - Geocoded data for 724 GEF projects spanning 4978 locations. Includes

projects identified as land degradation, biodiversity, multifocal area, and programmatic.
The file level1a.csv contains project, location, and financial data merged together using
unique project and location ids. Project level commitments have been disaggregated
evenly across all locations associated with a project. For more detail about this dataset,
please refer to the readme PDF file provided with the data.

• Source - AidData
• File Type - Comma Separated Values (.csv)

3. NDVI (Normalized Difference Vegetation Index) Satellite Imagery
• Description - NDVI is a satellite based measure of the "greenness" of vegetation. This is

a yearly aggregate of NDVI for 2010.
• Source - NASA LTDR AVHRR v42

• File Type - Raster (GeoTiff, .tif)

0.3.1 Base Layer
To get started, let’s add a background layer to QGIS so we have some spatial context when we add
our other data.

1. Click "Open Data Source Manager" button on the far left of the second row of the top toolbar
(shortcut: Ctrl+L).

1http://www.geoboundaries.org
2https://ltdr.modaps.eosdis.nasa.gov/cgi-bin/ltdr/ltdrPage.cgi

https://qgis.org/
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2. Go to the "Raster" tab and then use the browse button (...) for the "Source" field to navigate to
and select the .../Desktop/data/NE1_50M_SR_W/NE1_50M_SR_W.tif file

3. Click "Add" to load the base layer, and then click "Close". You should see a map similar to
below.

0.3.2 Nigeria State Boundaries
Now we can add in our Nigeria state boundaries.

1. Open the Data Source Manager again, but select the "Vector" tab this time.
2. Find and select the .../Desktop/data/NGA_ADM1.geojson file.
3. Click "Add" to add this layer.
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4. You can then right click on the layer in the layer window and select "Zoom to Layer" to get a
better view

5. Alternatively, you can use the "Zoom to Layer" button in the top toolbar.
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0.3.3 GEF Geocoded Aid Projects
Next, we will add our aid projects.

1. Open the Data Source Manager again, and select the "Delimited Text" tab this time.
2. For "File name", select the .../Desktop/data/geocoded_gef_projects/data/level_1a.csv file.
3. You can set the "Layer name" to "gef_aid"
4. QGIS should automatically load the selected .csv file to the window and detect the longitude

and latitude fields.
5. If it does not load automatically, make sure the "File Format" is set to "CSV" and "Geometry

Definition" is set to "Point coordinates"
6. Set "Geometry CRS" to "EPSG:4326 - WGS 84"
7. Click Add to load the selected .csv file, then "Close"
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8. You can use the "Identify Features" button (top toolbar, shortcut: Ctrl+Shift+I) to click on
any of the points added to the map. This will display details about the point in the "Identify
Results" window on the right side.

9. To further explore this data, right click the gef_aid layer and click Open Attribute Table.
The attribute table displays information associated with each features, or project location,
in the layer. Each row represents a geocoded project location, and each column contains a
specific information about the project location such as the project title, status, start year, or
commitments.
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10. The Attribute Table also allows you to select and filter locations, create new fields using the
field calculator, and zoom to selected fields. For example, you may wish to filter based on the
precision with which project location were able to be geocoded.

0.3.4 NDVI Satellite Imagery
Finally, we will add in our NDVI raster.

1. Using the Data Source Manager, go to the Raster tab and select the .../Desktop/data/nd-
vi/avhrr_ndvi_2010.tif file, then Add and Close
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2. The NDVI layer defaults to a grey scale display. To change this, and explore other information
about this layer, right click on the layer in the Layers window and select "Properties"

3. The "Information" tab will show basic statistics and metadata for this layer

4. Value distributions can be found in the "Histogram" tab
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5. Go to the "Symbology" tab to change the style or coloring of this layer to be more intuitive for
NDVI. We will Red-Yellow-Green color ramp in order to indicate low NDVI with and high
NDVI with green.

• Change "Render Type" to "Singleband Pseudocolor"
• Click on the dropdown arrow for "Color ramp" and then go to the "All Color Ramps"

option and select "RdYlGn"
• Next click the "Classify" button, then "Apply" and "OK"
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6. The new raster layer style should now be applied, like below
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7. You can use the same "Identify Features" tool from before to look at individual pixel values
but clicking at different points on the map. The values will appear in the "Identify Results"
window on the right.

8. To visualize our Nigeria state boundaries and aid projects on top of the NDVI layer, we can
adjust the order of layers in the "Layers" window by simply dragging layers.

9. Move the "NGA_ADM1" and "gef_aid" layers above the "avhrr_ndvi_2010" layer
10. Then, we can change the boundaries to display as only an outline instead of a solid fill.
11. Right click on "NGA_ADM1", go to "Properties" and then "Symbology"
12. Click on "Simple fill" (below "Fill" in the white box)
13. Then change "Symbol layer type" to "Outline: Simple line"
14. Change the "Color" and increase the "Stride width" to improve visibility
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15. Then click "Apply" and "OK".
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0.4 Preparing Data for Analysis
Using states in Nigeria as our unit of analysis, we will now explore how to aggregate both our GEF
Geocoded Aid Project (point data) as well as our NDVI satellite imagery (raster data) to these units.
This will provide us with a sum of project commitments for each state, as well as a mean NDVI
value for each state.

In this section we will first explore the tools and methods used to perform these aggregations
manually in QGIS. In the next section we will see how the GeoQuery web platform can be used to
make this process drastically faster and easier.

0.4.1 Point Data - Aid Projects
In this section, we are going to utilize a "Spatial Join" tool to calculate the total amount of project
commitments going to each state. The spatial join is an operation that aggregates the attribute data
from one layer (GEF geocoded aid) to another (Nigeria ADM1) based on a spatial association (e.g.,
overlapping) and an aggregation function (summation).

1. In the "Processing Toolbox" (right side of window) expand the "Vector general" section and
then double click "Join attributes by location (summary)"

2. Set "NGA_ADM1" as the Input layer (this is the layer we want data aggregated to)
3. Set "gef_aid" as the Join layer (layer which has data we want to aggregate)
4. Select "Contains" as the spatial operation in "Geomtric predicate".
5. Select "even_split_commitments" from "Fields to summarise"
6. Select "Count" and "Sum" from "Summaries to calculate"
7. Then click Run, and "Close" once it finishes (this may take a minute to complete, and will

add a new layer named "Joined layer" to you map when it is done)
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8. Check the attributes by right clicking the new layer and open the attribute table. The
"even_split_commitments_count" and "even_split_commitments_sum" columns are the output.
The count is the number of projects in each state. The sum is the sum of project commitments
for each state.

9. Right click on this layer and select "Rename Layer" to change the layer name to "spatial_join"
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10. Now let’s visualize distribution of aid across states in Nigeria
11. Right click on the spatial_join layer and click "Properties", then go to the "Symbology" tab
12. Change the "Simple Fill" drop down at the top to "Graduated" then select the "even commit-

ment split sum" column from the drop down directly below.
13. There are various data classification mode provided by QGIS, such as "Equal Interval", "Equal

Count", "Natural Break (Jenks)", "Standard Deviation", "Pretty Break". These classification
modes use different statistical algorithms to break down the data into separate categories. For
demonstration only and easy comparison with the later data visualization, we are going to use
"Natural Breaks (Jenks).

14. Click "Classify" button below
15. Finally, click "OK"
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0.4.2 Raster Data - NDVI

With the zonal statistics tool, a summary statistic is calculated for each of the administrative states,
based on overlapping pixel values from the input raster dataset. In this case, summary statistics of
NDVI values for each administrative state will be calculated.

1. First, create a copy of the "NGA_ADM1" layer by right clicking and selecting Duplicate
2. Then rename the new layer ("NGA_ADM1 copy") to "zonal_statistics" by right clicking and

selecting Rename

3. You can adjust the visibility of the "spatial_join" layer and new "zonal_statistics" layer by
clicking the checkboxes next to each layer. Let’s turn off the "spatial_join" and turn on the
"zonal_statistics" layer
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4. Open “Zonal Statistics” by going to the "Raster analysis" menu in the "Processing Toolbox"
and then selecting "Zonal statistics"

5. Set “avhrr_ndvi_2010” layer to be your Raster layer.
6. Set "zonal_statistics" to be the vector layer.
7. Set the “Output column prefix” to “zs_”.
8. Select "Count", "Mean", "Min", and "Max" from the "Statistics to calculate" options
9. Click "Run" and then "Close" when it finishes. This may take a moment to aggregate the raster

NDVI value to your Nigeria state boundaries



20

10. Next, right click "zonal_statistics" layer and click “Open the Attribute Table” to check the new
fields added by zonal stats

11. The new field representing the average NDVI value in each state can be found in the "zs_mean"
column. Additional "zs_" columns have been generated representing the other aggregation
methods (count of pixels, min NDVI value, max NDVI values)
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12. Now let’s visualize these average NDVI value for each state. Right click the "zonal_statistics"
layer and click “Properties” then go to the "Symbology" tab

13. Select “Graduated” from the menu at the top of the style window
14. Select “zs_mean” from the list of columns
15. Change the Color ramp to "RdYlGn"
16. Then click "Classify", and "OK"
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0.5 Using GeoQuery

Now that we have explored how to manually prepare data using QGIS, you can imagine what it would
be like if you had 20 different datasets you need to aggregate to 10 different sets of administrative
boundaries.

To help reduce technical barriers and processing burdens often associated with incorporating
spatial data into research, AidData developed GeoQuery to do the work for you. GeoQuery offers
over 45 datasets on aid, conflict, the environment, population, and more that can be aggregated to
administrative boundaries for every country in the world.

In this section we will look at how you can replicate the work we have just done in a fraction of
the time by using GeoQuery.

0.5.1 Web Interface
To get started with GeoQuery, go to geo.aiddata.org and click the Get Data button.

1. The first page of GeoQuery is where you can select the unit of analysis - or the geographic
boundaries you are interested in aggregating data to. Let’s search for "Nigeria"

2. Select ADM1 or state option for Nigeria (Nigeria ADM1 Boundary - GADM 2.8)

geo.aiddata.org
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3. Click the Search Datasets button to load all datasets in GeoQuery with data for Nigeria
4. Select Global Environment Facility Geocoded Aid Data v1.1.0 on the left of the data

selection screen. For this example, we will leave the default "All Sectors" filter and not select
any additional filters. Other filters available include: project title, project status, commitment
amount, start and end year, as well as location type and other geocoding details.

5. Click the Add to Request button.
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6. Next click the Normalized Difference Vegetation Index - NDVI (LTDR v4 - AVHRR)
dataset from the menu on the left

7. Choose Mean as the Extract Options, and 2010 under Years.
8. Click the Add to Request button.

9. Click Submit Request in the upper-right, then Review Request.
10. Enter the email address you would like the results sent to on the right, and click submit

With the above steps completed, your request will have triggered a job on the SciClone high per-
formance computing cluster at the College of William and Mary. All jobs are processed dynamically,
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so depending on the complexity of your request you will likely receive a completion email within 5
minutes to approximately 4 hours for extremely large or complex jobs.3

When your job is complete, you will receive an email directing you to the permanent download
page for that data. You can also always retrieve your history of data requests and downloads by
clicking "Past Requests" at the upper-right of GeoQuery and entering your email address.

If for some reason you cannot submit a new job or it is taking more than a few minutes to
complete, you can view the results page for an existing request we created for the same data:

http://geo.aiddata.org/query/#!/status/5c2e4511c15e002940b7ff8f

0.5.2 Understanding Results
Once your request is completed, you can download three different files: a PDF containing
descriptions of your data, a CSV containing your data itself, and a zip file containing everything
generated during your request (including CSV and documentation). If you download the CSV and
open it in a common program such a Libre Office or Excel, you will see an output very similar to
that seen below.

Each row represents a geographic boundary, and each column represents data associated with that
boundary. In the PDF automatically prepared for you, you will find a description of exactly what
each column means, how it was generated, and how to cite the underlying information. To identify
what a column name means, the quickest way to find it is to open your documentation PDF and

3The average request time is about 2 minutes but in some cases jobs may take 24 hours (or longer) depending on the
number of users on the system (i.e. if many users concurrently put in extremely complex jobs). If you have put in a request
for a job and it has been longer than 24 hours, you can reach out to the GeoQuery support team at geo@aiddata.wm.edu.

http://geo.aiddata.org/query/#!/status/5c2e4511c15e002940b7ff8f


0.5 Using GeoQuery 27

search through it (i.e., ctrl+f ) for the name of the column. Units and other key information are
provided in the documentation as well.

0.5.3 Visualizing Results in QGIS
In this section, we are going to visualize the data that you request from the last section. To save time,
we included the request results in the data folder for you.
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1. First, let’s move all of our existing layers into a group so that we can manage our data more
easily.

• Use the "Add Group" button in the "Layers" window to create a new group called "raw
data"

• Then select all the existing layers and drag them into this group
• You can now toggle the visibility of this group or collapse the group’s contents to make

room
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2. Next, let’s load in a fresh copy of our Nigeria state boundaries

3. Now we will add the GeoQuery results to QGIS as a data only layer. We will join this to our
Nigeria State boundaries after.

4. Add the .csv file by opening the Data Source Manager and using the "Delimited Text" tab to
add the .../Desktop/data/geo-
query_results/5c2e4511c15e002940b7ff8f/5c2e4511c15e002940b7ff8f_results.csv
file

5. Name the layer "geoquery_data"
6. Since this .csv is an attribute only file, make sure to select "No geometry" in the Geometry

definition.
7. Click "Add" and then "Close"

8. Now let’s join the GeoQuery data to our boundaries by right clicking on the new
"NGA_ADM1" layer and going to "Properties" and then the "Joins" tab

9. In the "Joins" tab, click "+" sign on the bottom.
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10. Choose "geoquery_data" as "Join Layer".
11. Select "gbid" as both the "Join field" and "Target field"
12. Click "OK" and then "Apply"

13. Without closing the Properties window, go to the Symbology tab to style our layer with the
newly joined data

14. Change the "Simple Fill" drop down at the top to "Graduated".
15. Select "geoquery_data_globalenvironmentfacility..." as the column.
16. Set the color ramp to "Blues"
17. Click "Classify" and the "OK"
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18. To visualize the NDVI data from GeoQuery, we will rename our layer to "geoquery_aid",
create a duplicate of the layer, and rename the duplicate to "geoquery_ndvi"

19. Open the layer properties for the "geoquery_ndvi" layer and go to the "Symbology" tab.
20. Change the column to "geoquery_data_ltdr_avhrr_ndvi_v4_yearly.2010.mean" in the column.
21. Set the color ramp to "RdYlGn"
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22. Click "Classify" and then "OK".

For general raster data, GeoQuery should usually provide similar results to the zonal statistics
method used in QGIS, but improvements in underlying algorithms often result in at least some
difference. Differences may be more noticeable in some cases for a variety of reasons including
raster measurement data resolution and the size of boundary features being used.

The methods for aggregating aid data used in GeoQuery are substantially different than the point
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based method we explored in QGIS. GeoQuery uses codes assigned during the geocoding process to
associate each project location with more realistic polygon based geometries. Aid is then dispersed
across these polygons rather than being assigned to a single point location.
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